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4.3   Training materials 

Authors: Stassini Frangou, Kyparisia Papanikolaou, Dimitris Alimisis 

Introduction 

In this section you can find all the worksheets used during pilot training courses. 
Each worksheet can be identified by the number of the module that belongs 
(C.3.1). The way to use each worksheet is described at the corresponding module 
of section 4.2. 

Table 4.3.1. Course outline 

Training Course Curriculum Outline 

Module Title Hours Materials 

C.1 Introduction 1   

C.2 ‘Didactic contract’ 1  Appendix 1 

C.3            Robotics as learning object                                13 

C.3.1 Introduction to LEGO NXT and sensors 2 Worksheet 
C.3.1 

C.3.2 A first approach to construction of robots 3  

C.3.3 A first approach to programming robots 3 Worksheet 
C.3.3 

C.3.4 “The cat, the mouse and the master” project 3 Worksheet 
C.3.4.1,  

Worksheet 
C.3.4.2,  

Appendix 
4,  

C.3.5 The ‘data logger’ 2 Worksheet 
C.3.5 

C.4           Theoretical framework                                         4 

C.4.1 Constructivism and Constructionism  2 Worksheet 
C.4.1 

C.4.2 Why robotics in education? 1 Worksheet 
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C.4.2 

C.4.3 Project-based learning 1 Worksheet 
C.4.3 

C.5           Methodology for developing robotic projects     14 

C.5.1 Model for organizing robotics projects 1 Worksheet 
C.5.1, 
Appendix 2 

C.5.2 An example of a robotics project: “BusRoute” 3 Worksheet 
C.5.2, 
section 3.2 

C.5.3 Working on a new robotics-enhanced project 7 Worksheet 
C.5.3 

C.5.4 Presentation and evaluation of the trainess’ 
projects 

3 Worksheet 
C.5.4 

C.6 Evaluation of the course 2 Worksheet 
C.6.1, 
Worksheet 
C.6.2 
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Worksheet C.3.1: Introduction to NXT brick and sensors 

ΝΧΤ brick and sensors-LEGO MINDSTRORMS NXT Edu Software 

1. A “robot” is a structure that can: 

 

 

 

 

According to the above, characterize the following items according to their 
function. 

Item Function 

Light sensor  

NXT display  

Play of sound  

ΝΧΤ brick  

Servomotor  

Touch sensor  

 

 

Collect data 
from the 

environment 
INPUT 

Process those 
data and make 

decisions 
PROCESSING 

Execute those 
decisions 
having a 
behavior 
OUTPUT
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2. The NXT brick can communicate with the computer through a USB cable or a 
Bluetooth connection. On the NXT brick, sensors, motors, lights are connected 
with cables. Name the sensors, and motors in the following picture. Please notice to 
which port each of these objects is connected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. ………… 

6. ……………………. 

2. ………… 

3. …………… 
4. ……………………. 

5. ……………. 



Teacher Education on Robotics-enhanced Costructivist Pedagogical Methods   
 

165 

3. Parts of the NXT: On the NXT brick, sensors, motors, lights are connected with 
cables. Study the following picture. 

 

4. Menu My Files: Open the ΝΧΤ brick and explore the NXT menu. Remember: 

Orange button: On/Off, Enter 

Light Grey arrows: navigation left and right 

Bark grey: Clear, go back 

Select My Files folder. Which subfolders can you find? 

 

1…………….…..…… 2…………….…..……..  3….…………….……….  

4. ……………………………… 

Open subfolder Sound Files and run the file Startup. 

Input ports 1,2,3,4: 
touch sensors, light 
sensors, temperature 
sensors etc. can be 

connected here. 

Output ports A, B, C: 
Motors and lights can be 
connected here. 

Enter button.  

Connection with 
PC 

Use the gray button to 
turn off the NXT or to 

move from a submenu to 
the main menu. 

We use these arrows to 
move through menus. 

Monitor window. Here the 
actions of the microprocessor 

are shown. 
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5. Menu View: The behaviour of a robot is usually based on the values of its 
sensors (e.g. light sensor). We can see the values of each sensor connected to our 
NXT by the View menu. 

5.α Measurement of Reflected Light: The Light Sensor enables the robot to read 
the light intensity in a room, and to measure the light intensity on colored surfaces. 
You can test the Light Sensor in different ways using View. 

Step 1: Connect the Light Sensor to the NXT (port 3). Select View in the NXT 
display. 

Step 2: Select Reflected light 

Step 3: Select the right port (port 3) and see the value of the light sensor on your 
NXT display. 

 

 

Hold the Light Sensor close to the different colours in your surrounding and see the 
different readings. Write your observation in the following table. 

Colour Value 

White  

Green  

Blue  

Light grey  

Black   

In front of the window  

……………………….  

Can the robot distinguish the color of a surface?  

 ……………………………………………………………………………………… 
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5.b Touch sensor: The Touch Sensor is a switch: it can be pressed or released. 

        pressed               released            bumped 

 

See the current Touch Sensor value on the display using View menu. 

Step 1: Connect the Touch Sensor to NXT (port 1). Select View in the NXT 
display. 

Step 2: Select the Touch icon.  

Step 3: Select the right port (port 1) and see the value on your NXT display. Press 
and release the button of the sensor. 

 

 

 

 

 

5.c Interactive Servo Motor: The Interactive Servo Motors have a built-in 
Rotation Sensor. The rotational feedback allows the NXT to control movements 
very precisely. The built-in Rotation Sensor measures the Motor rotations in 
degrees or full rotations. To test the rotation sensor connect the servomotor to NXT 

Step 1: Select View in the NXT display. 

Step 2: Select Motor degrees.  

Step 3: Select the right port (port A or B or C). Now try to attach a wheel to the 
Motor and measure the degrees by pushing the wheel over the floor. 

 

Can the robot distinguish the direction of rotation? 

…………………………………………………………………………………… 

Test the option Motor rotation… 

Condition Value 

Button Pressed  

Button released  
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Worksheet C.3.3 A first approach to programming 

 
Moving Around 

1. Moving forward: For programming the behavior of a robot we may use the 
Lego Mindstorms Edu NXT software. This is a graphical programming 
environment. All available blocks (commands) can be found on the left hand side 
of the screen.  

1.a. Open the Lego Mindstorms Edu 
NXT software and drag a Move block 
from the Common Palette on the 
workspace. Move Block can set our 
robot to go forwards in a straight line, 
backwards or to turn by following a 
curve. Duration (5), power (4), 
direction (2) of the motion can be 
defined by the properties of the block 
(configuration panel, lower part of the screen). Set the parameters of the 
configuration panel as below. (For more information on the properties of any block 
you can use the Help menu of the software).  

1.b. You have already made your first program. 
You can save it as move_fd.rbt. Can you guess 
what is going to happen if you run this program? 

1.c In order to test this program connect your 
NXT to you computer and open it. Press the 
Download button of the Controller (on the right 
side of your screen). You can run the program 
from the software (press the Rum button) or from 
the NXT buttons (Files/Software files 
/move_fd/run). (Make sure that the motors are 
connected to the right ports) 
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2. Speed and Power: The power of motors defines the speed of your robot. Make 
measurements of the distance traveled by your robot in a specific time interval for 
different values of motor’s power. Fill the following table with your measurments. 

 

 

 

 

 

Use the grid to construct a power-speed graph. Can you figure out the exact 
formula for speed?  

3. Turn Left: The Motor block allows for precise control 
of one motor’s speed. You can find it at the Complete 
Palette/Action/Motor. (For more information on the 
properties of any block you can use the Help menu of the 
software). 

3.a Write a program which changes the direction of your robot by 90 degrees to the 
right. Test your program. Save it as right_turn.rbt. 

3.b. Sketch your program below making some notes on the appropriate properties 
of each block (duration, power etc.) 

 

 

 

POWER 
Time 
(sec)  

Distance 
(cm) 

Speed 
(cm/sec)
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3.c. You can make a new command block which turns your robot to the right and 
save it for later use.  

Step 1: Select the blocks of your right_turn program by your mouse.  

Step 2: With the blocks selected, choose the Make a New My Block command from 
the Edit menu at the top of the NXT software interface. This will open the first 
screen of the My Block Builder wizard. 

Step 3: Give the name Right_turn to your new My Block. Then clik Next. 

Step 4: Use your mouse to drag an icon representing turn into the editing box. 
Click Finish when you are done. Your new Right_turn block will appear in your 
current program and in the Custom palette, which is accessible by clicking the 
right-most tab at the bottom of the programming palette.  

Now if you need to make your robot to turn right you can use this block.  

3.d Use the Move or Motor blocks, the Right_turn block and a 
Loop block to program your robot to move on a square path. Save 
your program as square.rbt. Upload your file to eclass at the area 
of your group. 

 

 

 

4. Make an investigation and propose a program that changes the direction of your 
robot by any angle. Upload your work at your group area of e-workspace. 

 

 

 

 

 

 

 

 

 

5. Use a few minutes to complete your diary. Write your ideas, thoughts or 
comments and upload it at your group area. 
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Worksheet C.3.4.1: The Cat, the Mouse and the Master (I ) 

When a robot acquires senses and control… 

In this activity, you will progressively construct a ‘cat-robot’ simulating the 
movement of a cat chasing mice. You will also need a mock up with small black 
areas around to put the robot move.  

1.A Cat chasing a Mouse: block, loop structure, light sensor 

1.a The cat-robot should make use of the C, B motors and should, also, include a 
light sensor, which provides input to port 3. Note that in order to connect the light 
sensor, follow the building instructions provided in the Lego Mindstrorms Edu 
NXT software, area of the Robot Educator/Common palette/16.Detect Dark Line 
/Building Instructions / Light Module Down).  

Open the Lego Mindstorms Edu NXT software. Develop the following program 
that simulates the movement of a ‘cat-robot’ that chases mice and name it as “cat-
robot.rbt”! The program may have the following form and is based on the ‘Wait 
Light’ block.  

 

 
 

1.b Make the cat-robot move: Let us suppose that your robot is a cat chasing a 
mouse (black spot on the floor)! Which are the individual steps that make up the 
cat’s behavior?  State them one after the other: 

1. …………………………………………………………………………………  

2. ………………………………………………………………………………… 

3. …..…………………………………………………………………………… 

4. ……………………………………………………………………………….. 

5. ……………………………………………………………………………….. 



  Chap.  4 –Teacher Training Course on Educational Robotics  

 

 

172

State the cat’s behaviours, as recorded during the preceding step, in 
correspondence with the commands included in the program and the necessary 
settings for each command.  

Behaviour Commands Conditions / Settings 

   

   

   

Run the program. In order to achieve the desired behavior, most probably you will 
need to make some changes to the control condition of the Wait Light block. 

1.c Develop your first procedure or block (Μy Block). Store the above program in 
a block (Μy Block) and name it ‘mouse-stop’. By creating a ‘ΜyΒlock’ command 
in your program, you may re-use the particular series of commands whenever you 
wish, provided that each time you call the block with that name!  

Tip: Use the following commands: Menu selection: Edit - Make A New My Block. 

1.d Use the block ‘mouse-stop’ and develop a program that  makes the cat stop for 
a while, when encountering a dark area, and then, change direction and continue to 
chase mice, i.e. looking for black areas on the white mock-up. Put below a 
screenshot of your program (use Alt - PrintScreen to save the current screenshot) 

 
 
 

1.e Loop construct: Modify the above program so that the cat should look for mice 
for 30 seconds! 

Tip: In order to form the loop structure, select from the left hand side menu the 
Common palette, the Loop block (attention with the control condition that 
terminates the Loop Block!).  

Put below the screenshot of your program (use Alt – PrintScreen to save the current 
screenshot) 

 

 

Save the final version of the program as cat_mouse_groupxxx.rbt (where xxx 
represents the number of your team)  at your group area of e-workspace. 

1.f  State in which ways you can terminate the loop structure: 
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2. The Cat encounters its Master: Selection structure, Touch sensor, Display, 
Sound, Wait For  

What is going to happen if the cat’s Master appears? At his/her touch, it will, 
probably, miaow, smile, stop for 3 sec and, then, will continue undeterred  its 
chasing effort. In that case, the cat’s behavior changes depending on the context. 
This behavior can be programmed using the Switch Block. 

2.a You need a Touch Sensor in your robot (port 1).  

In order to connect the sensor follow the building instructions provided in the Lego 
Mindstrorms Edu NXT software, area of the Robot Educator/Common palette/ 
18.Detect Τouch /Building Instructions / Touch Module Front. 

2.b Develop and test a program that simulates the cat’s behavior when chasing 
mice and it suddenly meets its master.  

State the behavior that you want the cat-robot to have when its master touches it.  

If [the cat gets a touch] then  

………………………………………………………………………………….. 

Enter the above functions in your program “cat_mouse_groupxxx.rbt”. Make use 
of the blocks Switch, Display, Sound. 

Tip: The Switch block is located at the left hand side menu Common palette 
(attention to the condition that controls the touch sensor!). Find there, also, the 
block Display (appearance of icon, text, or sensor values on the ΝΧΤ display), 
Sound (sound production) and Wait For (stops the motion).  Consult, also, the Brief 
Guide at the end of this worksheet.   

Save the program as ‘cat-mouse-man_groupxxx.rbt’. 

Save the worksheet as ‘Worksheet 3.4.1 _groupxxx.rbt’ 

Brief Guide 

‘Display’ Block: This block is used in order to display an icon, a text or 
to draft something on the ΝΧΤ brick monitor.  
‘Sound’ Block: This block is used in order to produce a sound.  The 
sound files are saved separately in the NXT in a special folder. 

‘Loop’ block: All of the blocks that are placed within a Loop are 
repeated for a specific number of times (count), for a specific time 
period (time), or until a certain condition is met (sensor) / forever 
(unlimited) according to the control condition which is selected.  

‘Switch’ block: When the sensor condition is set ‘true’, the program 
performs the command set No. 1; otherwise, it performs the 
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Sensor Condition

Commands 1st set  

Commands 2nd set 

command set No. 2. This command may take more than one conditions.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
‘Wait for’ block: delays the performance of the next block 
for the time defined in the appropriate parameter. In this 
case: wait for 1 second.  
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Worksheet C.3.4.2 The Cat, the Mouse and the Master (II) 

Selection construct, Variables and Data Input 

In this activity, you will progressively make the ‘cat-robot’ move in a spiral route.  

1. Open the Lego Mindstorms Edu NXT software. Search for the file 
spiral_display.rbt. You may ask your trainer for help. Study this program and try to 
describe the kind of behavior that you expect your robot to execute once it has run 
that program.  

Comment on the actions performed by each of the blocks of the program 
“spiral_display.rbt”. You can add comments above each block by using the tool 
Comment tool of the tool bar.  

2. Run the program:  What kind of actions does your robot perform?   

……………………..………………………………………………………………… 

After the observation of the cat’s behavior add or modify the comments on the 
actions performed by each block of the program “spiral_display.rbt”. This time use 
CAPITAL (upper case) letters. 

……………………..………………………………………………………………… 

Save your  program as “cat_spiral_move_groupxxx.rbt” at your group area of e-
workspace. 

3. What is the name of the variable that controls the distance run by your robot 
before turning? 

……………………..………………………………………………………………… 

Which is its initial value? 

 …………………………………………………………………… 

Which is its final value, as quoted in the ΝΧΤ screen? 

………….………………………….. 

Save your worksheet as “Worksheet4-3-2-groupxxx.rbt” at your group area of e-
workspace . 

Brief Guide 

Variable: The definition and use of variables in the Lego Mindstrorms Edu NXT 
environment is carried out in 3 steps.  

Step 1: Variable definition: Select from the Edit menu / the Define variables 
option. Define the name and the type of the variable (numeral, logic, text).  
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Step 2: Variable initialisation: Select 
from the Complete palette the command 
“Variable”. You can see the settings of 
this block at the following picture:  

 

 
 
 
 
 

Parameters of the variable block 
 

 

1. Select from the list the name of the variable you want to use in your program 
(variable definition is described in Step 1).  

2. Select the action that the Variable block will perform. By selecting the Write 
command, the variable acquires a value. With the Read option, the value of the 
variable becomes available in the program.  

3. Area wherein the value of the variable is defined. 

Step 3. We recall the value of the command and we can use it as input in other 
commands (option Read).  

Math Command: It allows the execution of arithmetic operations. It can take 
input values from other variables.   

 

 

 

Number to Text Command: It accepts as input a numerical value 
which it converts into a text and can display it, on the NXT display.   
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Worksheet C.3.5  The “data logger” 

Linear motion 

1. The NXT through the File Access Blocks can collect, save and 
retrieve data from timers or sensors.  

To collect and save the data you need three Access blocks. These 
three blocks could be positioned right next to each other or could 
be spaced throughout your program.  

The first File Access block (with “Delete” selected in its configuration panel) 
would clear content of the file. 

The second (with “Write” selected in its configuration panel) would write data to a 
file. 

The third File Access block (with “Close” selected in its 
configuration panel) positioned somewhere later in the 
program would close the file. 

To retrieve the data you should access NXT memory through 
ΝΧΤ Window button (on the Controller: NXT window/Memory/Others) and 
Upload the *.txt file to your computer).  

2. A simple data logging program that collects data from a timer and the ultrasonic 
sensor is shown at the following picture (comments in brackets [ ] are the 
parameters of each block). Try to make this program on your computer.  

2.a Please identify: The timer block, the ultrasonic block, the three File Access 
block and their functions. 

2.b. What is the name of the data file created by this program? 

2.c Which is the condition that terminates the loop? 

2.d What kind of data is going to be collected if you run this program? 
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3.a Create a parallel sequence beam by moving the mouse pointer over the starting 
point and pressing and holding your mouse button while you move it. Double click 
to finch this action. And blocks in order to make your robot moving forward with 
steady speed. Save your program as walldistance.rbt at your group area.  

3.b Add an ultrasonic sensor (find instructions in Lego Mindstrorms Edu NXT 
Robot Educator/Common palette/ 14.Detect distance/Building Instructions / 
Ultrasonic Module). You are ready to test your program. Make all necessary 
arraignments in your workspace and test it. 

3.c Download and run it. Retrieve the data file. 

4. Propose at least two activities, suitable for students who have already been 
introduced to linear motion with constant velocity, which will make use of this set 
of data.  

1st activity  …………………………………………………………………………. 

…………………………………………………………………………………….. 

…………………………………………………………………………………….. 

2nd activity ………………………………………………………………………….. 

………………………………………………………………………………………. 

……………………………………………………………………………………… 

5. Suggest a program which can collect data for uniform accelerated motion. 
Upload your program. 

 

 

 

 

 

6. Find more information about the functions of timer, ultrasonic, file access block 
at the Help menu of the software. 

 
 
 
 
 

7. Take a few minutes to complete your diary. Write your ideas, thoughts or 
comments and upload it at your group area. 
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Worksheet C.4.1 Constructivism and Constructionism 

1. Read the main points of the following paper with the members of your group (20 
min). 

Ackermann E., (2001) Piaget’s constructivism, Papert’s constructionism: What’s 
the difference? Future of Learning Group Publication   

2. Discuss and write down the main similarities and differences between 
constructivism and constructionism (20 min).  

3. Choose one representative from your group to present to the whole class your 
work (5 min) 

Worksheet C.4.2 Why robotics in education? 

1. Read a part from the article (20 min): 

Resnick M (2002). Rethinking Learning in the Digital Age. In The Global 
Information Technology Report: Readiness for the Networked World, edited by G. 
Kirkman. Oxford University Press.  

2. Discuss in your group the ideas presented by the author. Point out three reasons 
you consider as important for the introduction of robotics in school education. (20 
min) 

3. Upload in the forum area of the e-workspace a summary of what you have 
discussed (5 min). 

4. Choose one representative from your group to present to the whole class your 
work (5 min). 

Worksheet C.4.3 Project based learning 

1. Read the main points of the article (20 min): 

Mike Carbonaro, Marion Rex, Joan Chambers (2004) Using LEGO Robotics in a 
Project-Based Learning Environment, The Interactive Multimedia Electronic 
Journal of Computer-Enhanced Learning 6 (1) 2004 

2. Discuss in your group and point out three main advantages of the project-based 
learning against the traditional teacher-centered teaching model. (20 min) 

3. Upload in the forum area of the e-workspace a summary of what you have 
discussed (5 min). 

4. Choose one representative from your group to present to the whole class your 
work (5 min). 
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Worksheet C.5.1 Model for organizing a robotic project 

Activity 1 (20 minutes, work in groups of 4 trainees)     

In previous sessions of this course we have discussed thoroughly constructivism 
learning approach and its implications in teaching. Concerning Robotics in 
Education we have illustrated interesting features of learning by constructing 
artifacts and we have discussed the constructionist approach in teaching and 
learning. 

1. Make a list of seven features that a robotic project should have in order to serve 
constructivist and constructionism perspectives of teaching and learning. 

………………………………………………………………………………………. 
………………………………………………………………………………………. 

2. Be prepared to present your list to the whole class. 

Worksheet C.5.2 An example of a project: “The BusRoute” 

Activity 1 (35 minutes) 

“The BusRoute” is a robotic project designed for students of secondary education. 
Its duration is 12-14 teaching periods (45 minutes). The project follows the project 
model presented in previous sessions and it is developed in five stages: 
Engagement stage, Exploration stage, Investigation stage, Creation stage, 
Evaluation stage. 

Stage hours Teaching Theme Worksheets 

Engagement 
stage 

2 Public Transport 
A robot bus 

Worksheet 1 
Worksheet 2 

 
Exploration 
stage 

4-5 Getting to know the structural 
materials 
Construction of a robot car 
Programming a robot 
Use of light sensor 

Worksheet 3,  
Worksheet 4,  
Worksheet 5,  
Worksheet 6 

Investigation 
stage 

2-3 Construction of the bus 
Suggest a solution 

Worksheet 7 
Worksheet 8 

Creation 
stage 

1-2 Synthesize and Create Worksheet 9 

Evaluation 
stage  

1-2 Presentations & Discussion  
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We suggest you to select one of the above stages and study with your colleagues 
the description of this stage and the relevant worksheets. The materials are 
available through e-workspace (each group must select a different stage to study) 

Activity 2 (10 minutes) 

After the end of the Activity 1 discuss in your group the following issues: 

1. What kind of difficulties may a teacher face during the implementation of this 
stage?  

2. What kind of difficulties may the students face during the implementation of this 
stage? 

3. Complete the following table with activities that may be included in the stage 
you have studied. 

 

4. Be prepared to share your thoughts with the rest of your class.  
 
 

Stage  Teaching 
Strategies-Tools 

Student activities Teacher activities 

 
 

   

 
 

   

 
 

   

 
 

   

 
 

   



  Chap.  4 –Teacher Training Course on Educational Robotics  

 

 

182

Worksheet C.5.3 Working on a new robotics-enhanced project 

Developing a robotics-enhanced project: specifications 

We propose that your work includes either an activity or a project. Both cases 
should include actions involving students, promoting experimentation, exploration, 
open problems and self-evaluation. 

Follow the following pattern for the description of your work by answering each 
question included in each stage.   

Expected Results: What learning outcomes are expected (outcomes may be 
classified in knowledge, skills, attitudes and values)? 

Describe the stages of the project and develop the appropriate materials by 
answering the questions of each stage.  

Engagement Stage: What is the real problem set by this project? How are you 
going to involve your pupils in its formation?  

Exploration Stage: Which are the materials that students will use in their work? 
Which of the basic software functions will they utilize? How are the pupils going 
to be organized?  

Investigation Stage: Which of the open problems you would like your pupils to 
investigate? How are the pupils going to be organized in relation to the open 
questions that they will investigate? 

Creation Stage: How should the diary of the pupils be structured in order to reflect 
their actions and thoughts?  

Evaluation Stage: What kind of evaluation are you going to use: self evaluation, 
peer evaluation teacher evaluation? Select criteria and formulate rubrics.  

Stage Description  
Objectives 

Resources 
Expected 
Products 

Actions of 
students 

Engagement     
Exploration     
Investigation     
Creation     
Evaluation     

Brief Description of the project: Upload in the e-workspace a brief description of 
your project and other materials that may support your proposal.   
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Worksheet C.5.4 Presentation and evaluation of the projects 

Rubrics for assessing a robotics project 

 Novice Apprentice Practitioner Expert 

Authenticity 

Content and 
skills are 
connected to 
later use in 
school only. 

Content or 
skills are 
somewhat 
connected to 
life outside of 
school. 

Content and skills 
are clearly 
connected to life 
outside of school, 
such as the work 
world. 

Content and skills 
are highly 
relevant by 
connecting to 
students’ lives 
right now. 

Open-
Ended 

Task has only 
one correct 
response. 

Task allows 
limited room 
for different 
approaches. 

Task allows for 
different 
approaches based 
on the same 
content/skills 
base. 

Task allows 
students to choose 
different 
assessment 
measures for the 
task 

Complexity 

Task contains 
different 
skills, most 
lower order. 

Task contains 
many different 
skills and 
content. 

Task contains 
many different 
skills and content, 
including higher 
level thinking. 

Task contains 
many different 
skills and content, 
including higher-
level thinking. 
Task contains 
opportunities for 
students to choose 
some of the skills 
and content. 

Curricular 
Connection 

Task is loosely 
connected to 
key skills and 
content in 
curriculum. 

Task is clearly 
connected to 
key skills and 
content in 
curriculum. 

Task is connected 
to key skills and 
content in 
curriculum. 
time frame and 
scope of task 
match time frame 
and scope in the 
curriculum. 

All tasks are 
clearly connected 
to national 
curricular 
standards. 
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Appendix 1 . “Didactic Contract” 

During the module 2 (Agreeing on a "didactic contract") trainers and trainees 
discuss the overall aim, the specific objectives of the course, the training 
methodology and the expected training results. This discussion is expected to result 
in a “didactic contract” that will offer a better adjustment of the course to the 
trainees’ needs and interests. What follows is the “didactic contract” agreed with 
the trainees in the pilot TERECoP  training course held in ASPETE, Athens (April-
May 2008). 

The overall aim of the course is to provide opportunities for teachers to examine 
how robotic technologies can be used to promote a constructivist-constructionist 
approach to learning under a co-operative and collaborative frame of work. The 
implementation of robotics-enhanced constructivist teaching and learning practices 
demands that teachers play a new role. This means that opportunities, like exposure 
to a number of critical examples and experience in designing computer-based 
robotic activities and integrating them in their classroom practice in constructivist 
ways, are of great priority. The goal is teachers to be convinced by their own 
personal experience for the potentiality of robotic technology as learning tool.  

In this course we regard that technology alone cannot affect minds. The curriculum 
design will follow an innovative constructivist perspective with emphasis on 
aligning computer and robotic technology with subject matter and learners’ needs 
for the purpose of constructing meaning in social learning environments. In such 
learning environments the focus is not on the individual but on interactive systems 
that include individuals interacting with each other, instructional materials, subject 
matter, and tools. Computer-based robotics is an innovative technology that can 
create a rich interactive environment encouraging constructivist learning.   

The specific objectives are  

- to familiarise trainees with appropriate robotics-based learning environments 
including Lego Mindstorms NXT system  and a set of critical examples and 
activities that can support constructivist teaching and learning in science and 
technology subjects  

- to enable trainees to use robotics technology in a way that can contribute to the 
realisation of 

• meaningful learning based on students’ own team work with teaching 
materials 

• authentic learning using learning resources of real-life, occupational 
situations, or simulations of the every day phenomena,  

• social learning though the use of e-learning classes  
• active-reflective learning working on experiments or problem-solving and 

using available resources selectively according to their own interests, 
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search and learning strategies 
• project-based learning seeking solutions to real world problems, which are 

based on a technology-based framework 
- to create a community of practice between trainers and teachers for facilitating 

and sustaining teachers’ professional development in using robotic tools to 
support their students’ learning by active exploration and social construction of 
new knowledge. 

Pedagogical and didactical approach: Constructivist-constructionist pedagogy and 
a learner-centered didactical approach will be applied taking into consideration 
learner’s characteristics for an effective technology-enhanced learning design.  A 
collaborative e-learning environment will support the course based on the belief that 
the inherent dynamics of a necessary mutual process are likely to be more conducive 
to meaningful transformation, carrying so a sense of greater potential for 
development.  

The expected impact on trainees is to be trained in a way that robotic technology-
based learning will play an important aspect of their future work as teachers or 
professional educators. Trainees are expected to be able to 

- develop innovative collaborative strategies in their classes supported by the 
development of e-learning communities  

- select exploratory learning activities that can support social constructivist 
teaching and learning.  

- use the proposed tools in real classrooms situation.  
- design, build and program their own robotic models. 
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Appendix 2. Project –Based learning: Important features 

In previous sessions of this course the constructivism approach and its implications 
in teaching has been thoroughly presented. Concerning Robotics in Education 
interesting features of learning by constructing artefacts have been illustrated. 
Finally constructionist approach in teaching and learning has been discussed. At 
that point we suggested that the appropriate way to implementing robotics in a 
learning process is through projects. A robotic project with the following features 
may serve constructivism and constuctionism approach to teaching and learning. 

A robotics-enhanced project may focuses on creation of a product (artifact) that 
reflects learners’ abilities and learners’ understanding. Therefore project activities 
should be organized around a question (driven question) or a theme which can 
guide learners progressively through the learning process. The driven question or 
theme of the project should be open ended in order to serve different learning goals 
and different learning styles. It is also very important for a successful project, that 
the theme of the project is significant and meaningful for the learners. For example, 
projects which deal with real life problems provoke students’ interest and 
motivation. 

In a project learners are actively involved in the formation of the driven question 
and in the description of the final product. Clarification of the goals of the project 
and the criteria for assessment of the final product (rubrics) are collaboratively 
agreed by student and teachers in the beginning of the project. Learners organize 
their work by themselves and they work autonomously over extended periods of 
time.  

Teacher is a facilitator /mediator of the learning process. S/he creates a learning 
environment and provides support for the learners. S/he allows them to take as 
much responsibility for their own learning as they can. Teacher keeps the balance 
between guiding his/hers students through learning activities and challenging them 
with interesting questions for further investigation.  

Communication in group level and in the classroom is an important element of a 
project. Learners express their ideas and test their understanding through their 
collaboration in small group or in the classroom. Feedback from each other and the 
teacher give learners the opportunity to improve their work and meet the learning 
goals of the project. 
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Appendix 3. Methodology for organizing robotics-enhanced projects 

Engagement 
stage: 

Students are provided with an open-ended problem and get involved 
in defining the project. This stage requires the identification and 
representation of a scientific problem. Students work as a class 
putting their ideas into a question format. As they are doing so, they 
are identifying and representing a problem and different issues 
involved (e.g. brainstorming at class level). 

Exploration 
stage: 

Students get familiar with LegoLogo, controlling devices and 
software, make hypothesis and test their validity in real conditions, 
provide initial ideas. Students are divided in groups in order to 
answer to simple questions and study specific cases in order to get 
familiar with the controlling devices and software (e.g. work in 
groups with worksheets – structured activity). 

Investigation 
stage: 

Students search for resources and investigate alternative solutions. 
Students reconsider the problem and the different issues rose during 
the engagement stage based on their experience gained through the 
exploration stage. At this stage students in collaboration with the 
teacher formulate the driving questions/problems which link with 
the learning goals of the project. The student groups undertake to 
solve the particular problems, investigate alternative solutions and 
argument on their final proposals concerning the artifact and the 
software the developed (e.g. work in groups with worksheets, keep 
diary – open activity).  

Creation 
stage: 

Students share and combine their artefacts, synthesize ‘solutions’ to 
the project reflect on their initial ideas. Students present their work 
in class and then each group work on the synthesis of a final 
‘product’ including the artifact and the software (e.g. work in 
groups with worksheets, keep diary – result in a product). This work 
may lead to similar solutions but also  to innovative proposals. 

Evaluation 
stage: 

Students share their ideas, products at class level, argument on their 
final proposals and evaluate them. Alternative solutions are 
presented at class level and evaluated based on the driving 
questions/criteria posed in previous stages of the project (stages of 
engagement, investigation). At this stage students should critically 
judge their work, express their opinions, compare their works, and 
reach a common proposal to the project (e.g. make presentations, 
discuss, peer evaluation). Students should also reflect on and 
evaluate their collaboration.  
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Appendix 4 

Description of the spiral_display.rbt (to be used with worksheet 3.4.2) 

 
 


